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修正部分描述不准确内容
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术语表

MSOP 主数据流输出协议，Main data Stream Output
Protocol，简称：MSOP

DIFOP 设备信息输出协议，Device Info Output Protocol，简

称：DIFOP
UCWP 用 户 配 置 写 入 协 议 :User Configuration Write

Protocol，简称：UCWP
Azimuth 雷达的水平角

Timestamp 时间戳，记录系统时间

Header 协议包中的帧头

Tail 协议包中的帧尾
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非常感谢您购买了 RS-LiDAR-16激光雷达产品，请您认真阅读并祝您使用愉快！

1 安全提示

为避免损坏设备及违反保修条款，请勿打开传感器。

 激光安全等级

本产品激光安全等级符合以下标准：

IEC 60825-1:2014;

 阅读说明 - 请在使用本产品之前，认真阅读所有安全和操作说明。

 遵循说明 - 请遵循所有操作和使用说明。

 保留说明 - 请保留所有安全和操作说明，以备将来参考。

 注意警告 - 请遵守产品和操作说明中的所有警告，以免发生意外。

 产品维修 - 在操作中描述的内容之外，请不要尝试维修产品。如需维修，请及时联系本

公司。
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2 产品简介

RS-LiDAR-16是深圳市速腾聚创科技有限公司新推出的 16线激光雷达，是世界领先的

小型激光雷达，主要面向无人驾驶汽车环境感知、机器人环境感知、无人机测绘等领域。

RS-LiDAR-16采用混合固态激光雷达方式，集合了 16个激光收发组件，测量距离高达

150 米，测量精度+/- 2cm 以内，出点数高达 300,000 点/秒，水平测角 360°，垂直测角

-15°~15°。

RS-LiDAR-16通过 16个激光发射组件快速旋转的同时发射高频率激光束对外界环境进

行持续性的扫描，经过测距算法提供三维空间点云数据及物体反射率，可以让机器看到周围

的世界，为定位、导航、避障等提供有力的保障。

图 1 RS-LiDAR-16激光雷达成像系统

该设备的使用过程包括以下步骤：

 连接 RS-LiDAR-16设备；

 解析数据包获得旋转角，测距信息，以及校准反射率；

 依据雷达的旋转角，测距以及垂直角度计算 XYZ坐标值；

 根据需求存储数据；

 可读取设备当前状态配置信息；

 可根据需求重新配置以太网、时间、转速信息。
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3 产品规格1

3.1 规格参数

表 1 产品规格

传感器  TOF法测距 16通道

 测距：40cm至 150米（目标反射率 20%）2

 精度：±2cm（典型值，具体分布参考图 2精度说明）3

 视角（垂直）：±15°（共 30°）

 角分辨率（垂直）：2°

 视角（水平）：360°

 角分辨率（水平/方位角）：0.1°（5Hz）至 0.4°（20Hz）

 转速：300/600/1200rpm（5/10/20Hz）

激光  Class 1

 波长：905nm

 激光发射角（全角）：水平 7.4mrad，垂直 1.4mrad

输出  ~300k点/秒

 百兆以太网

 UDP包中包含

距离信息

旋转角度信息

经校准的反射率信息

同步的时间标签（分辨率 1us）

机械／电子操作  功耗：12w(典型值)4

 工作电压 ：9-32VDC（需要配备接口盒子和稳定的电源）

 重量：0.87kg（不包含数据线）

1 以下数据只针对量产产品，任何样品、试验机等其他非量产版本可能并不适用本规格数据，如有疑问请

联系速腾聚创销售；
2 测距能力以 20% NIST漫反射板作为目标，测试结果会受到环境影响，包括但不限于环境温度、光照强度

等因素；
3 测距精度以 50% NIST漫反射板为目标，测试结果会受到环境影响，包括但不限于环境温度、目标物距离

等因素，且精度值适用于大部分通道，部分通道之间存在差异；
4 设备功耗测试结果会受到外部环境影响，包括但不限于环境温度、目标物的距离、目标物反射率等因素；



RS-LiDAR-16 用户手册

4

 尺寸： 直径 109mm * 高 80.7 mm

 防护安全级别：IP67

 工作环境温度范围：-30℃~60℃5

 存储环境温度范围：-40℃~85℃

3.2 精度说明

图 2 精度与目标物距离关系

5 设备运行温度可能会受到外部环境影响，包括但不限于光照环境、气流变化等因素；
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4 电气接口

4.1 设备电源

在配备接口盒子一同使用的时候，设备供电要求电压范围 9-32 VDC，推荐使用 12

VDC。

如果不使用接口盒子给连接雷达的端子供电，必须使用经过稳压的 12VDC。V4.0及以

后版本雷达将宽压功能集成在雷达内部，所以可以使用 9-32VDC直接给雷达供电。

设备工作状态下功耗约为 12W（典型值）。

4.2 电气安装

RS-LiDAR-16激光雷达从主机下壳体侧面引出的缆线（电源/数据线）的另一端使用了

标准的 SH1.25接线端子，接线端子针脚序号如下图所示。

用户使用 RS-LiDAR-16可将 SH1.25端子插入 Interface BOX中对应的位置。

图 3 接线端子针脚序号

RS-LiDAR-16具备使用航插接口的版本，雷达侧面主机到航插头的线缆长度为 1米。航
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插接口上具体引脚定义如下：

Pin Wire Color Function
1 Red +12V
2 Yellow +12V
3 White GROUND
4 Black GROUND
5 Green GPS PULSE
6 Blue GPS REC
7 Brown LiDAR Ethernet RX-
8 Brown white LiDAR Ethernet RX+
9 Orange LiDAR Ethernet TX-
10 Orange white LiDAR Ethernet TX+

图 4 航插接口引脚序号

4.3 Interface Box接口说明

RS-LiDAR-16出厂默认接驳 Interface BOX。

RS-LiDAR-16附件 Interface BOX具有电源指示灯及各类的接口，可接驳电源输入、网

线及 GPS输入线。其端口包含：设备电源输入（DC 5.5-2.1母座），RS-LiDAR-16数据输出

（RJ45网口座）以及 GPS设备输入（SH1.0-6P母座）。航插版接口盒线长有 3米，有其他

线长需求请联系 Robosense技术支持。因为雷达版本不同，接口盒 GPS口的定义和电平要

求有两种，各接口相对应的位置如下图所示：
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Pin No. V4.0 and later versions Other versions

1 GPS PULSE GPS REC

2 +5V GPS PULSE

3 GND GND

4 GPS REC NC

5 GND NC

6 NC +5V

图 5 Interface BOX接口定义

注意：RS-LiDAR-16的“地”与外部系统连接时，外部系统供电电源负极（“地”）与 GPS

系统的“地”必须为非隔离共地系统。

电源正常输入时，红色电源输入指示灯亮起；电源正常输出时，绿色电源输出指示灯亮

起。当输入指示灯点亮，输出指示灯暗灭时，Interface BOX进入保护状态。如输入指示灯

及输出指示灯同时暗或灭时，请检查电源输入是否正常，如电源输入正常，即 Interface BOX

可能已经损坏，请返厂维修。

GPS接口定义：GPS REC 为 GPS UART 输入；GPS PULSE为 GPS PPS输入。

网络接口遵循 EIA/TIA568标准。

电源接口使用标准 DC 5.5-2.1 接口。
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4.4 Interface Box连接

接电源适配器

接电脑主机以太网口

图 6 Interface Box连接示意图

接 GPS同步模块（可选）

Interface box
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5 通信协议

RS-LiDAR-16与电脑之间的通信采用以太网介质，使用 UDP协议，输出包有两种类型：

MSOP包和 DIFOP包。文中所有涉及 UDP的协议包均为 1290byte定长，其中 1248byte为

有效载荷，其余 42byte为 UDP封包开支。RS-LiDAR-16网络参数可配置，出厂默认采用固

定 IP和端口号模式，按照如下表格。

表 2 出厂默认网络配置表

IP地址 MSOP包端口号 DIFOP包端口号

RS-LiDAR-16 192.168.1.200
6699 7788

电脑 192.168.1.102

设备默认 MAC地址是在工厂初始设置的，但是设备 MAC地址可根据需求改动。

使用设备的时候，需要把电脑的 IP设置为与设备同一网段上，例如 192.168.1.x(x的取

值范围为 1~254)，子网掩码为 255.255.255.0。若不知设备网络配置信息，请连接设备并使

用 wireshark抓取设备输出包进行分析。

RS-LiDAR-16和电脑之间的通信协议主要分三类，一览表见下表格。

 主数据流输出协议 MSOP，将激光雷达扫描出来的距离，角度，反射率等信息封装

成包输出给电脑；

 设备信息输出协议 DIFOP，将激光雷达当前状态的各种配置信息输出给电脑；

 用户权限写入协议 UCWP，用户可以根据自己需求，重新修改激光雷达的某些配置

参数。

表 3 设备协议一览表

（协议/包）名称 简写 功能 类型 包大小 发送间隔

Main data Stream
Output Protocol

MSOP 扫描数据输出 UDP 1248byte 约 1.33ms

Device Information
Output Protocol

DIFOP 设备信息输出 UDP 1248byte 约 100ms

User Configuration
Write Protocol

UCWP
配置设备参数

输入
UDP 1248byte INF

注：下面章节皆为对协议中的有效载荷（1248byte ）部分进行描述和定义。
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5.1 主数据流输出协议（MSOP）

主数据流输出协议：Main data Stream Output Protocol，简称：MSOP

I/O类型：设备输出，电脑解析

默认端口号为 6699

MSOP包完成三维测量相关数据输出，包括激光测距值、回波的反射率值、水平旋转角

度值和时间戳。MSOP包的有效载荷长度为 1248字节，其中 42byte的同步帧头 Header ，

1200byte的数据块区间（共 12个 100byte的 data block），以及 6byte帧尾 Tail。

单回波数据包的基本结构如下图所示:

图 7 单回波 MSOP Packet 数据包定义示意图

2 n 12
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双回波数据包的基本结构如下图所示:

图 8 双回波 MSOP Packet 数据包定义示意图

5.1.1 帧头

帧头 Header共 42byte，用于识别出数据的开始位置。

在 Header的 42byte数据中有 8byte用于数据包头的检测，剩下 34byte中，21~30byte

存储时间戳，第 31byte用于表示激光雷达的型号，其余作预留处理，为后续的更新升级使

用。

Header的 8byte定义为 0x55,0xAA,0x05,0x0A,0x5A,0xA5,0x50,0xA0，可作为包的检查

2

第

二

次

回

波

第

一

次

回

波

n 12
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序列。

定义的时间戳用来记录系统的时间，分辨率为 1us，可以参考附录 B.10中的时间定义

以及本章第 3小节的表 8对时间的解析。

第 31byte的激光雷达的型号标识位描述如下表 4所示：

表 4 LiDARModel标志位描述

LiDARModel （1 byte）

0x01 RS-LiDAR-16

0x02 RS-LiDAR-32

5.1.2 数据块区间

数据块区间是 MSOP包中传感器的测量值部分，共 1200byte。它由 12个 data block组

成，每个 block长度为 100byte，代表一组完整的测距数据。Data block中 100byte的空间

包括：2byte的标志位，使用 0xffee表示；2byte的 Azimuth，表示水平旋转角度信息，每

个角度信息对应着 32个的 channel data，包含 2组完整的 16通道信息。（通道序号与垂直

角度的关系参见文中第 9章中的定义）。

5.1.2.1 角度值定义

在每个 Block中，RS-LiDAR-16输出的水平角度值是该 Block中第一个通道激光测距时

的角度值。角度值来源于角度编码器，角度编码器的零位即角度的零点，水平旋转角度值的

分辨率为 0.01度。事实上每个 data block区域有 32组的 channel data，对应两次 16线测

距信息，而每个 data block只有一个水平旋转角度值，因此单回波模式下每个 data block水

平旋转角度值对应于该data block中的第一次16线测距中的第一通道的测量时的水平角度，

第二次 16线测距中的第一通道的水平角度对应需通过在点云解析过程中进行插值计算得到

新的角度（插值做法请参考 5.1.2.2的介绍说明）。

例如，在图 10中，数据包的角度值计算方式是：

获取的数据包里的角度值得十六进制数：0x00，0x44。

将数据组成 16bit，为 16bit无符号整型数据。表示为：0x0044。

转换为十进制数字：68。

除以 100。
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结果：0.68度。

因此，这次的发射激光角度值为 0.68度。

注意：设备规定的角度值为零对应的位置为图 14中 Y轴正方向所指位置。

5.1.2.2 角度插值

RS-LiDAR-16每隔一组 16线激光测距才输出一次水平旋转角度信息，因此在单回

波模式下，对于没有输出水平旋转角度信息的那组 16线激光测距需要通过插值来获得。

有很多种方式可以插值，下面的方法是最简单和直接的一种。

对于一个 Packet 中的数据，Block 1 和 Block 2 的第一个数据采集的时间间隔是

~100us，可以认为在这个期间雷达是匀速旋转的。因此可以计算第 N+1组 16线激光测

距的第一个数据的水平角度是第 N组 16线激光测距的第一个数据的水平角度和第 N+2

组 16线激光测距的第一个数据的水平角度的均值。

如下是伪代码，代码会检测在第N组到第N+2组的时候是否水平旋转角度从 359.99

经过 0度。如下设定 N=1：

// First, adjust for a rollover from 359.99° to 0°
If (Azimuth[3] < Azimuth[1])
Then Azimuth[3]:= Azimuth[3]+360;

Endif;
// Perform the interpolation

Azimuth[2]:=Azimuth[1]+((Azimuth[3]-Azimuth[1])/2);
// Correct for any rollover over from 359.99° to 0°

If (Azimuth[2]>360)
Then Azimuth[2]:= Azimuth[2]-360;

Endif

5.1.2.3 channel data 定义

channel data是 3byte，高两字节用于表示距离信息，低一字节用于表示反射率信息，

如下图所示。
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表 5 channel data 示意图

Channel data n （3 byte）

2 byte Distance 1 byte Reflectivity
Distance1 [15:8] Distance2 [7:0] Reflectivity(反射率信息)

Distance 是 2byte，单位为 cm，分辨率因为雷达固件版本的不同，有 1cm和 0.5cm的

区别。

反射率信息为相对反射率，其具体定义参考“反射率信息解读”章节的描述，反射率信息

可以反映实测环境下系统的反射率性能，通过反射率信息可以完成对不材质物体的区分。

channel data的解析如下：

例如，在图 9/10中，数据包的 channel data 解析，计算方式是：

获取数据包里的距离值的十六进制数：0x06 ,0x42 。

将数据组成 16bit，为 16bit无符号整型数据。表示为：0x0642。

距离值转换为十进制数字：1602。

根据距离分别率不同，可计算。

1cm分辨率结果：16.02米；0.5cm分辨率结果 8.01米；

因此，这次的测距距离是 16.02米。

5.1.3 帧尾

帧尾（Tail）长度 6byte，4byte位预留信息，2byte的 0x00，0xFF。

5.1.4 数据包示范数据
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图 9 MSOP packet 展示

图 10 1cm精度 data block 区数据展示

图 11 0.5cm精度 data block 区数据展示
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5.2 设备信息输出协议（DIFOP）

设备信息输出协议，Device Info Output Protocol，简称：DIFOP

I/O类型：设备输出，电脑读取

默认端口号为 7788

DIFOP是为了将设备序列号（S/N）、固件版本信息、上位机驱动兼容性信息、网络配

置信息、校准信息、电机运行配置、运行状态、故障诊断信息定期发送给用户的“仅输出”协

议，用户可以通过读取 DIFOP解读当前使用设备的各种参数的具体信息。

一个完整的 DIFOP Packet的数据格式结构为同步帧头，数据区，帧尾。每个数据包共

1248byte：包括 8byte同步帧头 Header ，1238byte的数据区，以及 2byte帧尾 Tail。

数据包的基本结构如下表所示。

表 6 DIFOP Packet的数据格式结构

段落划分 序号 信息 Offset 长度（byte）

Header 0 DIFOP识别头 0 8
Data 1 电机转速 8 2

2 以太网 10 22
3 FOV设置 32 4
4 预留 36 2
5 电机锁相相位 38 2
6 主板固件版本号 40 5
7 底板固件版本号 45 5
8 反射率曲线校准值 50 240
9 反射率曲线系数 290 1
10 反射率计算模式 291 1
11 序列号 292 6
12 零度角标定值 298 2
13 回波模式 300 1
14 上位机驱动兼容信息 301 2
15 时间 303 10
16 运行状态 313 18
17 预留 331 11
18 故障诊断 342 40
19 GPRMC 382 86
20 预留 468 697
21 垂直角校准 1165 48
22 预留 1213 33

Tail 23 帧尾 1246 2

注：表格中 Header（DIFOP 识别头）为 0xA5,0xFF,0x00,0x5A,0x11,0x11,0x55,0x55，可作为包的检
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查序列。

Tail帧尾内容为 0x0F,0xF0。

每一项信息的寄存器的定义以及使用参见用户手册附录 B中的详细描述。

5.3 用户配置写入协议（UCWP）

用户配置写入协议:User Configuration Write Protocol，简称：UCWP

I/O类型：主机向设备写入

UCWP实现功能：用户根据需求可以对设备的以太网、时间、电机参数重新配置。

一个完整的 UCWP Packet的数据格式结构为同步帧头，数据区。每个数据包共 48byte：

包括 8byte同步帧头 Header和 40byte的数据区组成。

具体内容遵照的协议参考下表。

表 7 UCWP Packet的数据格式结构

段落划分 序号 信息 Offset 长度（byte）
Header 0 UCWP识别头 0 8

Data

1 电机转速 8 2
2 以太网 10 22
3 FOV设置 32 4
4 时间 36 10
5 电机锁相相位 46 2

注：表中 Header（UCWP识别头）为 0xAA,0x00,0xFF,0x11,0x22,0x22,0xAA,0xAA，其中 Header前 4个字

节作为包的检查序列，即 0xAA,0x00,0xFF,0x11。

在此声明，RS-LiDAR-16并不包含电池系统及掉电后可持续运行的 RTC，在无 GPS或者

无 GPS信号时，启动 RS-LiDAR-16后必须由 PC通过 UCWP协议向设备写入时间，否则则按

照默认的一个系统时间计时。

见附录 B中对以太网、时间、电机转速、电机相位锁定四个寄存器的详细定义。

如用户想重新设置 LiDAR IP为 192.168.1.105，目的 PC IP为 192.168.1.225，Max_ADDR

为 001C23174ACC，MSOP包端口为 6688，DIFOP包端口位 8899，FOV起始角度为 0度，

FOV结束角度为 120 度，时间 2017 年 3 月 10 日 9 点 45 分 30 秒 100ms 200us，转速为

600rpm，电机锁相相位 90度时，根据 UCWP Packet和每个寄存器的定义，可以按照如下

表格通过向 LiDAR发送 UDP包进行重新配置。
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表 8 配置示例

信息 更改内容 配置内容 长度（byte）

Header
0xAA,0x00,0xFF,0x11,0x
22,0x22,0xAA,0xAA

8

转速 600rpm
0x02
0x58

2

LiDAR IP
（LIDAR_IP）

192.168.1.105

0xC0
0xA8
0x01
0x69

4

目的 PC IP
（DEST_PC_IP）

192.168.1.225

0xC0
0xA8
0x01
0xE1

4

设备地址

（MAC_ADDR）
001C23174ACC

0x00,0x1C,0x23,
0x17,0x4A,0xCC

6

MSOP端口（port1） 6688 0x1A20 2
MSOP端口（port2） 6688 0x1A20 2
DIFOP端口（port3） 8899 0x22C3 2
DIFOP端口（port4） 8899 0x22C3 2

FOV起始角度 0 0x0000 2

FOV结束角度 12000 0x2EE0 2

时间

2017年

3月

10日

9点

45分

30秒

100ms
200us

0x11
0x03
0x0A
0x09
0x2D
0x1E

0x00,0x64
0x00,0xC8

10

电机调相 90 0x005A 2

使用本协议配置设备时，不可进行字节级或区段级寻址、写入，必须完整写入整个列表；

列表写入后对应功能即刻更新，但网络参数会在下次启动设备的初始化流程中生效。

注：RSVIEW软件提供了通过 UCWP设置设备参数的可视化界面功能，对于 UCWP协

议不理解的情况下建议使用 RSVIEW来进行参数调整。在进行参数写入过程时，请勿断电，

务必在写入完成后进行断电，否则存在参数配置错误的风险。
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6 GPS同步

RS-LiDAR-16可外接 GPS模块，并且将 GPS发出的时间同步为设备的系统时间，也可

以将 GPS发出的 GPRMC消息保存到 DIFOP包中输出。

6.1 GPS时间同步原理

GPS模块连续向设备发送 GPRMC数据和 PPS同步脉冲信号，PPS同步脉冲长度为 20ms

至 200ms，GPRMC数据必须在同步脉冲上升沿 500ms内完成。

6.2 GPS使用

RS-LiDAR-16雷达 GPS_REC接口电平协议有两种，分别为 3.3V TTL电平标准和 RS232

电平标准；可以通过查看底板固件版本来区分，底板版本 08开头的为 TTL协议，09开头

的为 RS232协议；查看固件版本请查看附录 C中的图 C14。

RS-LiDAR-16电源盒上面的 GPS_REC接口规格为 SH1.0-6P母座，引脚定义如图 5所示。

两种协议的区别有两点，分别为:

TTL电平引脚定义：

引脚 GPS REC 接收来自 GPS 模块输出的 3.3V TTL 电平标准的串口数据;

引脚 GPS PULSE 接收 GPS 模块输出的正 TTL 同步脉冲信号;

RS232引脚定义：

引脚 GPS REC接收来自 GPS模块输出的 R232电平标准的串口数据

引脚 GPS PULSE接收 GPS模块输出的正同步脉冲信号，电平要求 3.0V~15.0V;

若您使用的 GPS输出是 RS232串口协议，而雷达接收端的电平是 TTL时，则需要自行

购买 RS232转 TTL的电平转换模块，例如接线图及定义如下：

图 12 RS232转 TTL电平转换模块

PPS
③
②
① TXD

Interface
Box

GND
④
⑤

⑥ VCC

③
⑥

①
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引脚+5V可以给 GPS模块供电（如果是 3.3V供电的 GPS模块请自行进行电压转换。同

时不要对+5V引脚进行输入供电，因为该引脚是输出引脚。

引脚 GND为外接 GPS模块提供接地。

外接的 GPS模块需要设置输出串口的波特率为 9600bps，8bit数据位，无校验位，停

止位 1。RS-LiDAR-16只读取 GPS模块发出的 GPRMC格式的数据，其标准格式如下：

$GPRMC,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>*hh

<1> UTC时间

<2> 定位状态，A=有效定位，V=无效定位

<3> 纬度

<4> 纬度半球 N(北半球)或 S(南半球)

<5> 经度

<6> 经度半球 E(东经)或W(西经)

<7> 地面速率

<8> 地面航向

<9> UTC日期

<10> 磁偏角

<11> 磁偏角方向，E(东)或W(西)

<12> 模式指示(A=自主定位，D=差分，E=估算，N=数据无效)

*后 hh为$到*所有字符的异或和

目前市场的 GPS模块发出的 GPRMC消息长度存在不一致情况，RS-LiDAR-16在 DIFOP

包中预留的 GPRMC消息长度最长为 86byte，可以兼容大部分市场上的 GPS模块发出来的

GPRMC消息格式，如果发现不兼容情况请联系 Robosense技术支持。
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7 关键特性

7.1 回波模式

7.1.1 回波模式原理

RS-LiDAR-16支持多种回波模式，分别为：最强回波（Strongest Return）、最后回波（Last

Return）及双回波(Dual Return)模式，当设置为双回波模式时，此时目标物的细节会增多，

数据量是单回波的两倍。

由于光束发散，任何一次激光发射出去都有可能产生多次激光返回。当激光脉冲发射出

去后光斑逐渐变大。假设一个光斑足够大，可以打到多个目标物上，产生多个反射。通常情

况下目标物距离越远，它在接收器上的能量就越弱，明亮或反光的表面情况可能会相反。

RS-LiDAR-16分析接收到的多个返回值，并根据情况输出最强、最后或同时输出最强最

后两个回波值。如果设置为最强回波模式则只输出最强的反射回波值。同样，如果设置是最

后回波模式，则只有最后时间上的回波输出；如果设置为双回波模式时，则会同时输出最强

和最后回波信息。

注意：只有当 2个距离物体之间距离大于 1米时才会有两次回波。

7.1.2 最强回波

当雷达光束只打到一个物体上的时候，此时只有最强回波。

7.1.3 最强，最后及双回波

当激光雷达发送的激光脉冲，投射到两个不同距离下的两面墙面或其他物体时，会返回

两个回波，此时有以下两种结果：

（1）最强回波不是最后回波的时候，返回最强和最后回波；

（2）最强回波既是最后回波的时候，返回最强回波和第二强回波；

7.1.4 回波模式标志

RS-LiDAR-16出厂默认为最强回波（Strongest Return）模式，如您需要更改设置，请参

照本用户手册附录 C RSView中的图 C14。在 DIFOP中第 300个 byte是回波模式的标志位，

具体对应如下：
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表 9 回波模式和标志位对照表

标志位 回波模式

00 双回波

01 最强回波

02 最后回波

7.2 相位锁定

当多个 RS-LiDAR-16近距离放置工作的时候，我们会观察到由于某个传感器接收了另外

一个传感器发射的激光而产生干扰。为了减少传感器间的相互干扰，RS-LiDAR-16提供相位

锁定的功能，能够减少设备相互间的干扰。

相位锁定功能可用于设定 RS-LiDAR-16在 PPS脉冲触发的时刻，传感器旋转到特定的

角度发射激光，当多个 RS-LiDAR-16同时使用的时候保持他们之间相对旋转角度不变。为了

保证相位锁定功能正常，需要 PPS脉冲触发信号且保持稳定。

图 12为 RS-LiDAR-16设置不同相位的示意图，红色箭头表明，当 PPS脉冲触发的时候，

传感器分别旋转到 0度、135度、270度发射激光。

图 13 RS-LiDAR-16不同相位设定示意图

RSVIEW客户端的 Tools > RS-LiDAR Information中提供了一个“Phase Lock”的参数

设定，可以用于设定锁定的相位角度，输入范围是 0~359。

相位锁定功能需要激光雷达转速设置在 600转或 1200转的时候才生效。
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8 点云呈现

8.1 坐标映射

由于雷达封装的数据包仅为水平旋转角度和距离参量，为了呈现三维点云图的效果，将

极坐标下的角度和距离信息转化为了笛卡尔坐标系下的 x,y,z坐标，如图 14所示，他们的转

换关系如下式所示：

� ⷈ め �銨㤄 ��� 㤄銨㤄 � ���
� ⷈ め �銨㤄 ��� �銨㤄 � ���

� ⷈ め 㤄銨㤄 ����

其中 め为实测距离， 为激光的垂直角度， 为激光的水平旋转角度，x、y、z为极坐

标投影到 X、Y、Z轴上的坐标。

图 14 雷达极坐标和 XYZ坐标映射

注 1：在 RS-LiDAR-16ROS包源码中，默认进行了坐标变换来符合 ROS的右手坐标系，ROS下面的 X轴定

义指向图 14中的 Y正方向，ROS下面的 Y轴定义指向图 14中的 X负方向。

注 2：雷达的坐标原点定义在雷达结构中心，高度距离底座 39mm。

8.2 典型场景点云呈现

当激光雷达扫描平面墙体时，呈现出类似双曲线分布轮廓图，如图 15所示，这是因为

16线激光雷达在圆形环境中扫描一周的路径为若干个向上或向下的圆锥面，其形成的点云

图为为圆形，当扫描的环境不为圆形时，其点云图为所有圆锥面与扫描环境的交线。因此，
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当激光雷达扫描平面墙体时，矩形面与圆锥面的交线为一系列的双曲线，如图 16所示。

图 15 XZ平面上的轮廓线

图 16 雷达扫描示意图

当然，也可通过极坐标转化为直角坐标的公式说明这一现象，如图 17所示推导过程，

最终得到表达式为

1
))tan(( 2

2

2

2


y
x

y
z
 的双曲线。当 y和 为一个定值时, 其表示焦点在

z轴上的双曲线；当 y一定时，�越大，双曲线的渐进线斜率越小，离心率越小，双曲线形

状越弯曲，�越小，双曲线的渐进线斜率越大，离心率越大，双曲线形状越平坦；当 一定

时，y越大，则同一角度的渐近线斜率一致，y值的不同影响整个轮廓线的疏密程度。
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图 17 直角坐标转化为双曲线推导过程
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9 垂直角度定义

图 18 RS-LiDAR-16俯仰角定义

RS-LiDAR-16在垂直方向的角度范围是-15°~+15°，角度间隔为 2°均匀分布。将 16个

激光器定义为 16路通道，与真实的垂直角度对应关系如图 18所示。
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表 10 激光通道序号与激光器垂直角度对应

通道序号 激光器理论垂直角度值

1 -15

2 -13

3 -11

4 -9

5 -7

6 -5

7 -3

8 -1

9 +15

10 +13

11 +11

12 +9

13 +7

14 +5

15 +3

16 +1

16通道顺序完成一轮发射所需的时间为 55.5us。
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10 反射率信息解读

RS-LiDAR-16数据中包含了被测物体反射率信息，反射率是衡量一个物体对光的反射能

力的指标，与物体本身的材质有很大的关系。因此，可利用此信息区分不同材质的物体。

在 RS-LiDAR-16数据中，标定后的反射率范围区间为 0~255，漫反射物体的反射率强

度在 0~100分布，黑色物体反射率低，白色物体反射率高。全反射的物体的反射率强度值

定义为 101~255，最理想的全反射物体的反射率接近 255。

图 19 反射率的标定

如果要计算每个点的反射强度信息，需要根据MSOP包中的反射强度值和反射率标定文

件一同计算得到。反射率标定文件可以从设备包装箱中提供的 U 盘中获取，文件路径为

configuration_data/curves.csv。具体的计算公式建议参考 RS-LiDAR-16 ROS 驱动中的

rawdata.cc文件中的 calibrateIntensity( )函数。
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注一：因为设备的固件升级，反射强度的计算方式 calibrateIntensity( )函数做过几次调整，

新的代码中向下兼容早期设备固件。反射率的计算方式一共有三种，其中前两种都需要通过

公式将激光雷达直接输出的 intensity字节进行转换才能够得到最终的结果；V4.0版本的设

备采用 mode 3方式直接使用激光雷达输出的 intensity，计算转换在激光雷达内部完成。

注二：出厂日期在 2018.11.20后的设备，mode 3方式直接使用激光雷达输出的 intensity，

计算转换在激光雷达内部完成。
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11 故障排除

在使用设备的过程中，我们会遇到一些常见的使用方面的问题，本章列举了部分常见的问题

以及对应的问题排查方法。

问题 解决方法

Interface Box上面红色指示

灯不亮或闪烁

 检查输入电源连接和极性是否正常

 检查输入电源的电压和电流是否满足要求（12V电压输入

条件下，输入电流≥2A）
Interface Box上面红色指示

灯亮，绿色指示灯不亮或闪

烁

 检查 Interface Box与设备端的连接线是否松动

设备电机不旋转  检查 Interface Box上面指示灯是否正常，确认电源输入是

否正常

 检查 Interface Box与设备端的连接线是否松动

设备在启动时不断重启  检查输入电源连接和极性是否正常

 检查输入电源的电压和电流是否满足要求（12V电压输入

条件下，输入电流≥2A）
 检查设备安装平面是否水平或雷达底部固定螺丝是否拧

的太紧

设备内部旋转，但是没有数

据

 检查网络连接是否正常

 确认电脑端网络配置是否正确

 使用另外的软件（例如 wireshark）检查数据是否有被接

收

 关闭防火墙和其他可能阻止网络的安全软件

 检查电源供电正常

Wireshark可以收到数据但

是 RSVIEW不显示点云

 关闭电脑防火墙，并且运行 RSVIEW通过防火墙

 确认电脑的 IP配置和设备设置的目的地址一致

 确认 RSVIEW上面的 Data Port设置正确

 确认 RSVIEW 安装目录或配置文件存放目录不包含任何

中文字符

 确认 wireshark中收到的数据包是 MSOP类型的包

设备存在频发的数据丢失  确认网络中是否有大量的其他网络数据包或网路冲突

 确认网络中是否存在其他网络设备以广播模式发送大量

数据造成传感器数据阻塞

 确认电脑的性能和接口性能是否满足要求

 移除其他所有网络设备，直连电脑确认是否存在丢包现象

无法同步 GPS时间  确认 GPS模块波特率为 9600bps，8bit数据位，无校验位，

停止位 1
 确认 GPS模块输出为 3.3V TTL还是 RS232电平

 确认 1PPS脉冲连续且连线正确

 确认 GPRMC的 NMEA消息格式正确

 确认 GPS模块和 Interface Box共地
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 确认 GPS模块收到了有效的解

设备通过路由器后无数据

输出

 关闭路由器的 DHCP 功能或在路由器内部设置传感器的

IP为正确的 IP
点云成像形状异常  确认使用的雷达配置文件正确

ROS 驱动显示点云的时候

有一个固定的空白区域不

断旋转

 此现象正常，是因为 ROS驱动按照固定包数进行分帧显

示，空白部分的数据会在下一帧进行显示

RSVIEW软件输出点云成一

条射线

 如果是windows 10系统请设置 RSVIEW使用成 windows
7兼容模式运行
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附录 A 精确的点时间计算

在每个 MSOP Packet中，有 12个 Block，每个 Block有 2组完整的 16线激光数据，因

此一个 Packet中有 24组完整的激光数据。16通道激光完成一轮发射和充能需要 55.5us。

两线激光之间发射的时间间隔是 2.8us，16线激光完成一轮发射时间为 2.8*16=44.8us，并

有 10.7us的额外间隔时间，所以一轮发射和充电的时间周期是 2.8*16+10.7=55.5us。

假设激光的序号 data_index是 1-16，激光发射轮数序列为 sequence_index是 1-24。每

个 MSOP Packet的时间戳是第 1个激光点的时间，为了计算每个激光点的时间，需要将每

个激光点的时间偏移量加到时间戳上。

时间偏移量 Time_offset:

Time_offset = 55.5us * (sequence_index -1) + 2.8us * (data_index-1)

精确的每个激光点的时间 Exact_point_time：

Exact_point_time = Timestamp + Time_offset

表 A-1 MSOP Packet中每个激光点的时间偏移量
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附录 B各寄存器定义详情

此处内容补充 5章节中协议里定义各个信息的定义，便于用户对设备的使用和开发。

B.1 电机转速（MOT_SPD）

电机转速寄存器（共 2bytes）

序号 byte1 byte2

功能 MOT_SPD

寄存器说明：

（1）本寄存器用以配置电机转向和电机转速；

（2）数据存储采用大端模式；

（3）配置转速列表如下：

（byte1==0x04）&&（byte2==0xB0）：转速 1200rpm，顺时针旋转；

（byte1==0x02）&&（byte2==0x58）：转速 600rpm，顺时针旋转；

（byte1==0x01）&&（byte2==0x2C）：转速 300rpm，顺时针旋转；

配置其他数据，电机转速皆为 0。

B.2 以太网（ETH）

以太网寄存器（共 22bytes）

序号 byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8

功能 LIDAR_IP DEST_PC_IP

序号 byte9 byte10 byte11 byte12 byte13 byte14 byte15 byte16

功能 MAC_ADDR port1

序号 byte17 byte18 byte19 byte20 byte21 byte22

功能 port2 port3 Port4

寄存器说明：

（1）LIDAR_IP为 LiDAR的源 IP地址，占据 4byte

（2）DEST_PC_IP为目的 PC的 IP地址，占据 4byte

（3）MAC_ADDR为 LiDAR的 MAC地址

（4）port1~port4 为端口号信息，port1 为 MSOP 包 LiDAR输出的端口号，port2 为

MSOP 包目的 PC 接收端口号，port3 为 DIFOP包 LiDAR输出的本地端口，port4 为 DIFOP

包目的 PC接收端口号。默认情况建议 port1和 port2设置相同，port3和 port4设置相同。
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B.3 FOV设置（FOV_SET）

FOV设置（共 4bytes）

序号 byte1 byte2 byte3 byte4

功能 FOV_START FOV_END

寄存器说明：

设置设备输出有效数据的水平角度范围，FOV_START和 FOV_END调整范围 0~36000，

对应角度 0~360°，存储方式为大端模式。比如：byte1=0x5d，byte2=0xc0，byte3=0x1f，

byte4=0x40，则：

FOV_START = 93*256+192=24000

FOV_END = 31*256+64=8000

表明有效的数据输出的水平角度范围为 240.00°~80.00°。

注：以上 byte已由十六进制转化为十进制后进行计算。

B.4 电机锁相相位(MOT_PHASE)

电机锁相寄存器（共 2bytes）

序号 byte1 byte2

功能 MOT_PHASE

寄存器说明：

调整电机在整数秒的旋转相位，配合 GPS的 PPS脉冲使用，调整值范围 0~360，对应

角度 0~360°，存储方式为大端模式，比如：byte1=0x01、byte2=0x0e，则电机转动相位值

为 1*256 + 14=270；

注：以上 byte已由十六进制转化为十进制后进行计算。

B.5 主板固件版本(TOP_FRM)

主板固件版本（共 5bytes）

序号 byte1 byte2 byte3 byte4 byte5

功能 TOP_FRM

寄存器说明：

该版本号与主板固件文件版本号对应，对应关系如下：

固件文件版本号： T6R23V6_T6_A

协议输出版本号： 06 23 06 06 A0

即协议输出版本号为：0x06230606A0

版本号中标记“_A”表示发布程序版本 Application，“_F”表示工厂模式程序版本 Factory。
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B.6 底板固件版本(BOT_FRM)

底板固件版本（共 5bytes）

序号 byte1 byte2 byte3 byte4 byte5

功能 BOT_FRM

寄存器说明：

该版本号与固件文件版本号对应，对应关系如下：

固件文件版本号： B7R14V4_T1_F

协议输出版本号： 07 14 04 01 F0

即协议输出版本号为：0x07140401F0

版本号中标记“_A”表示应用程序版本 Application，“_F”表示工厂模式程序版本 Factory。

B.7 垂直角校准（COR_VERT_ANG）

垂直角校准寄存器（共 48bytes）

序号 byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8 byte9

功能 1通道垂直角度 2通道垂直角度 3通道垂直角度

序号 byte10 byte11 byte12 byte13 byte14 byte15 byte16 byte17 byte18

功能 4通道垂直角度 5通道垂直角度 6通道垂直角度

序号 byte19 byte20 byte21 byte22 byte23 byte24 byte25 byte26 byte27

功能 7通道垂直角度 8通道垂直角度 9通道垂直角度

序号 byte28 byte29 byte30 byte31 byte32 byte33 byte34 byte35 byte36

功能 10通道垂直角度 11通道垂直角度 12通道垂直角度

序号 byte37 byte38 byte39 byte40 byte41 byte42 byte43 byte44 byte45

功能 13通道垂直角度 14通道垂直角度 15通道垂直角度

序号 byte46 byte47 byte48

功能 16通道垂直角度

寄存器说明：

（1）每个通道的垂直角校准信息存储采用大端模式；

（2）LSB = 0.0001度；

（3）角度值为无符号整数，1~8通道角度为俯视角度，9~16通道角度为仰视角度；

比如 9通道寄存器值为 byte1 = 0x00，byte2 = 0x27，byte3 = 0x10，则 9通道的垂直角

度值为：（0*2562+ 39 *256+16）*0.0001 = 1度，为仰视角度。

B.8 序列号（SN）

序列号寄存器（共 6bytes）

序号 1byte 2byte 3byte 4byte 5byte 6byte

功能 SN
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类似 mac地址，以 16进制共 6bytes数值指示设备序列号。

B.9 上位机驱动兼容性信息（SOFTWARE_VER）

提供上位机版本兼容信息说明。

B.10 时间（UTC_TIME）

时间寄存器（共 10bytes）

序号 byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8

功能 year month day hour min sec ms

序号 byte9 byte10

功能 us

寄存器说明：

1) year

reg name：set_year

序号 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

功能 set_year[7:0]：数据 0~255对应 2000~2255 year

2) month

reg name：set_month

序号 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

功能 保留 保留 保留 保留 set_month[3:0]：1~12month

3) day

reg name：set_day

序号 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

功能 保留 保留 保留 set_day[4:0]：1~31 day

4) hour

reg name：set_hour

序号 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

功能 保留 保留 保留 set_hour[4:0]：0~23 hour

5) min

reg name：set_min

序号 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

上位机驱动兼容寄存器（共 2bytes）

序号 byte1 byte2

功能 SOFTWARE_VER
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功能 保留 保留 set_min[5:0]：0~59 min

6) sec

reg name：set_sec

序号 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

功能 保留 保留 set_sec[5:0]：0~59 sec

7) ms

reg name：set_ms

序号 bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8

功能 保留 保留 保留 保留 保留 保留 ms[9:8]

序号 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

功能 set_ms[7:0]

注：set_ms[9:0]值范围：0~999

8) us

reg name：set_us

序号 bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8

功能 保留 保留 保留 保留 保留 保留 us[9:8]

序号 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

功能 set_us[7:0]

注：set_us[9:0]值范围：0~999

B.11 运行状态（STATUS）

运行状态寄存器共 18bytes

序号 byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8

功能 Idat1_reg Idat2_reg Vdat_12V_reg

序号 byte9 byte10 byte11 byte12 byte13 byte14 byte15 byte16

功能 Vdat_12V_M_reg Vdat_5V_reg Vdat_3V3_reg Vdat_2V5_reg

序号 17byte 18byte

功能 Vdat_1V2_reg

寄存器说明：

（1）Idat，包括 2路电流值，其中 Idat1是设备供电电流，Idat2是主板供电电流。每

路电流值大小由 3byte组成，组成 Idat_reg[23:0]。其中最高位 Idat_reg[23]是符号标志位，

Idat_reg[23] = 1 为负值，Idat_reg[23] = 0 为正值。Idat_reg[22:0]对应电流值大小，LSB为

1uA，电流计算公式：

�datⷈ �݀�ܽ�め�̴ܽ�݀�����݃�݁ݎݎ��め�̴݃ݎݎ� ⷈ ��
� �݀�ܽ�め�̴ܽ�݀����݃�݁ݎݎ��め�̴݃ݎݎ� ⷈ ��

比如，当 byte1 = 0x8C，byte2 = 0xD5，byte3 =0x 00时，实际电流值：
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Idat = -Idat_reg[22:0] = -0x0CD500 uA = -840960uA≈-841mA

Vdat，包括（ݎ） 6路电压值，每路电压值大小由 2byte组成，组成 Vdat_reg[15:0]。其

中高 4位 Vdat_reg[15:12]数据无效。Vdat_reg[11:0]对应电压值大小，各路电压计算公式如

下：

以上电压计算公式的单位是伏特（V）。

B.12 故障诊断（FALT_DIGS）

故障诊断寄存器（共 40bytes）

序号 byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8

功能 内部调试使用

序号 byte9 byte10 byte11 byte12 byte13 byte14 byte15 byte16

功能 内部调试使用 cksum_st manc_err1 manc_err2 gps_st

序号 byte17 byte18 byte19 byte20 byte21 byte22 byte23 byte24

功能 temperature1 temperature2 temperature3 temperature4

序号 byte25 byte26 byte27 byte28 byte29 byte30 byte31 byte32

功能 temperature 5 内部调试使用 r_rpm1

序号 byte33 byte34 byte35 byte36 byte37 byte38 byte39 byte40

功能 r_rpm2 内部调试使用

寄存器说明：

（1）表中 byte11的 cksum_st是读取 EEPROM的温飘补偿值的校验和的出错状态指示，

cksum=0x00表示温飘补偿值正常可用，cksum=0x01表示温飘补偿值不正常，FPGA内部温

飘校正出错。

（2）manc_err1和 manc_err2用于计算数据通信传输的误码率，manc_err1用于计算

1bit误码率，manc_err2用于计算 2bit误码率。误码率的计算公式如下：

��㤄���めめ����め ⷈ ��㤄���めめݎ��ൌൌݎ� ܽ ���ܿ

��㤄���めめݎ���め ⷈ ��㤄���めめݎݎ�ൌൌݎ� ܽ ���ܿ

manc_err1_per或 manc_err2_per为 0时，表明通信传输值正常。

（3）temperature1，temperature2是底板温度，temperature3，temperature4是顶板
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温度。温度值大小由 2byte 组成，低 3 位 temperature[2:0]数据无意义。高 13 位

temperature[15:3]是 温 度 有 效 值 ， 其 中 最 高 位 temperature[15]是 符 号 标 志 位 ，

temperature[15] = 0为正值，temperature[15] = 1为负值。温度计算公式：

ܽ����め�ܽ�めݐ��� ⷈ
ܽ����め�ܽ�め���ൌ݁݃ݎ ��ݎ �ܽ����め�ܽ�め���ൌ݃ ⷈ ��
� ��ሺ�ͺݎ � ܽ����め�ܽ�め���ൌ݁ݎ�݃ݎ��� �ܽ����め�ܽ�め���ൌ݃ ⷈ ��

Temperature5 是底板温度。温度值大小由 2byte组成，高 4 位 temperature[15:12]数据无

意义。低 12位 temperature[11:0]是温度有效值，其中最高位 temperature[11]是符号标志

位，temperature[11] = 1为负值，temperature[11] = 0为正值。温度计算公式：

ܽ����め�ܽ�め�ൌ ⷈ
ܽ����め�ܽ�め����݁�݃ݐݎ �ܽ����め�ܽ�め����݃ ⷈ ��
� ��ͺݐ� � ܽ����め�ܽ�め����݁�݃ݐݎ� �ܽ����め�ܽ�め����݃ ⷈ ��

（4）byte16是 GPS信号输入状态寄存器 gps_st，该寄存器使用 3个比特位，用于指示

当前接入的 PPS信号和 GPRMC信号是否有效，同时指示当前系统运行的时间是设备本地计

数时间还是同步到 UTC。bit位定义如下：

GPS信号输入状态寄存器 GPS_ST

比特号 功能 状态值 状态说明

bit0 PPS标志：

PPS_LOCK

0 PPS信号无效

1 PPS信号有效

bit1 GPRMC标志：

GPRMC_LOCK

0 GPRMC信号无效

1 GPRMC信号有效

bit2 UTC锁定标志：

UTC_LOCK

0 LiDAR内部时间没有和 UTC时间进行同步

1 LiDAR内部时间正在和 UTC时间进行同步

bit3~bit7 预留 x N/A

（5）电机的实时转速，由 byte32和 byte33两个字节组成，计算公式如下：

电机实时转速 = (256 * r_rpm1 + r_rpm2)÷6

（6）其他寄存器是内部调试使用寄存器

B.13 GPRMC数据包-ASCII码数据类型

GPRMC数据包位预留了 86个字节，根据外接的 GPS模块输出的 GPRMC消息长度自适

应完整的存储所接收到的 GPRMC消息，可以 ASCII码进行解析查看。
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附录 C RSView

在本附录中将展示如何使用 RSView获取、可视化、保存和回放 RS-LiDAR-16数据。

对于从 RS-LiDAR-16得到的原始数据，可以使用一些免费工具去检测，例如Wireshark 和

tcp-dump。但对于可视化这些数据，使用 RSView是更为便捷和容易实现的方式，本次使用

的版本为 RSView3.1.5。

C.1 软件功能

RSView提供将 RS-LiDAR-16数据进行实时可视化的功能。RSView也能回放保存为 pcap

文件格式的数据，但是还不能支持.pcapng格式的文件。

RSView将 RS-LiDAR-16得到距离测量值显示为一个点。它能够支持多种自定义颜色来

显示数据，例如反射率、时间、距离、水平角度和激光线束序号。所显示的数据能够导出保

存为 CSV格式，RSView3.1.3以后的版本支持导出 LAS格式的数据；之前的版本不支持导出

LAS、XYZ或者 PLY格式文件。

RSView所包含的功能:

 通过以太网实时显示数据

 将实时数据记录保存为 PCAP文件

 从记录的 PCAP文件中回放

 不同类型可视化模式，例如距离、时间、水平角度等等

 用表格显示点的数据

 将点云数据导出为 CSV格式文件

 测量距离工具

 将回放数据的连续多帧同时显示

 显示或者隐藏 RS-LiDAR-16中个别线束

 裁剪显示

C.2 安装 RSView

RSView的安装文件支持Windows的 64位操作系统，安装前不需要安装其他依赖软件。

RS-LiDAR-16 的包装里面的 U 盘中有 RSView 的安装包 RSView_X.X.X_Setup.exe。也

可以从 Robosense的官网（http://www.robosense.cn/resource）上面下载最新版本 RSView
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安装包。点击执行并根据安装提示操作即可，安装完后会在桌面生成快捷方式。安装路径不

可以有中文字符。

C.3 设置网路

在第 5章中有提到雷达出厂时设定的发送电脑的 IP地址，因此默认情况下需要设定计

算机的静态 IP的地址为 192.168.1.102，子网掩码为 255.255.255.0。此外还需要确保 RSView

没有被防火墙或第三方安全软件给禁止。

C.4 可视化数据

1. RS-LIDAR-16接通电源，并用网线和电脑连接。

2. 右键使用管理员权限运行打开 RSView软件。

3. 点击 File > Open 并且选择 Sensor Stream (图 C-1)

图 C-1 打开 RSView实时数据显示

4. 在弹出的 Sensor Configuration窗口中，选择 RSlidar16,“Type of Lidar”勾选 RS16，

“Intensity”选择 Mode3,之后点击“OK”即可，如下图 C-2所示：

图 C-2 选择 RS-LIDAR-16参数配置文件
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5. RSView 开始显示实时采集到数据(图 C-3)。可以通过点击 Play按钮暂停，再点击一次

可以继续显示。

图 C-3 雷达点云数据

C.5 保存 RS-LIDAR-16数据为 PCAP格式

1. 在实时显示数据时点击 Record按钮(图 C-4)。

图 C-4 RSView保存按钮

2. 在弹出的 Choose Output File对话框中，选择需要保存的路径和保存的文件名后，点击

“保存（S）”按钮(图 C-5)。RSView将开始将数据包文件写入目标 pcap文件中。(注意：

RS-LiDAR-16将会产生大量的数据，随着记录时间变长，目标 pcap文件将会变大。因此最

好将记录文件保存到 HDD或者 SSD中，而不是保存到较慢的 USB设备或者用网络保存)。
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图 C-5 RSView保存对话框

3. 再次点击 Record按钮停止保存 pcap数据。

C.6 回放 pcap数据

可以使用 RSView对 RS-LiDAR-16保存的数据 pcap文件进行回放或者测试。您可以使

用 Play按钮去播放或者选择数据中个别帧。也可以用鼠标选择 3D点云数据中的一部分，

然后打开表格进行分析。pcap文件的保存路径不可以有中文。

1. 点击 File > Open并且选择 Capture File。

图 C-6 打开 pcap记录文件

2. 弹出 Open File对话框，选择一个记录的 pcap文件并且点击“打开（O）”按钮。
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图 C-7 打开 pcap记录文件

3. 弹出 Sensor Configuration 对话框，添加并选择正确的 RS-LiDAR-16 的配置文件并点击

OK按钮。

4. 点击 Play按钮可以播放或者暂停数据。使用 Scrub滑动工具前后滑动可以选择数据中不

同位置的帧，此工具和 Record按钮在同一个工具栏内(图 C-8)

图 C-8 RSView Play按钮和 Scrub滑动工具

5. 为了得到更为具体的分析，选择一帧您感兴趣的数据并且点击Spreadsheet按钮(图C-9)。

一个侧边栏数据表将会显示在软件中右边，在表中包含了这一帧所有的数据。

图 C-9 RSView表格工具

6. 可以调整表格每列的宽度，或者排序得到更直观的显示。



RS-LiDAR-16 用户手册

45

图 C-10 RSView表格显示

7. 点击 Spreadsheet中的 Show only selected elements，可以得到所选择点对应的数据(图

C-11)。

图 C-11 RSView show only elements工具

8. 点击 Select All Points工具，这使得您的鼠标变成一个数据点选择工具（图 C-12）。

图 C-12 RSView Select All Points工具

9. 在 3D数据显示空间中，使用鼠标画一个长方形框住一些数据点，这些点的数据将会在

Spreadsheet被选择，并且在图中会变成粉红色(图 C-13)。
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图 C-13 RSView List Selected Points工具

10. 任何被选中的点都可以通过 Spreadsheet>Show only selected elements>Output CSV data

保存。

C.7 RS-LiDAR-16 工厂固件信息配置

RSView提供了集成了 UCWP协议的工具可以用来配置 RS-LiDAR-16工厂固件设定的转

速、以太网参数、时间参数、可选输出角度及回波模式。

在配置 RS-LiDAR-16 工厂固件的参数的时候，需要首先保证 RS-LiDAR-16 设备已经正

常连接并且可以实时显示数据。点击 Tools > RS-LiDAR Information，会弹出配置窗口。点

击窗口中 Get按钮，会显示当前 RS-LiDAR-16内部固件设定的参数。

图 C-14 读取雷达内部参数
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我们可以在窗口中修改我们想设定的参数（红色框中的只是举例，使用过程中以实际情

况为准），然后点击 Set LiDAR。提示成功后，再次 Get查看 RS-LiDAR Information确认参

数是否被修改成功。

图 C-15 设置雷达内部参数

注 1：在进行参数设定过程中，一定不要断电 LiDAR，否则会造成 LiDAR内部参数保存

错误。

注 2：如果修改了 RS-LiDAR-16工厂固件的 MSOP Port或 DIFOP Port参数，重新连接

设备的时候需要先根据 C.8节配置 RSView的 Data Port。

C.8 配置 RSView Data Port

RS-LiDAR-16默认的 MSOP端口号是 6699，默认的 DIFOP端口号是 7788，如果在 C.7

节中修改了这 2个参数或用其他方式修改了 RS-LiDAR-16的端口号，我们则需要重新设定

RSView 获取数据的 Data Port 为修改后的端口号，否则将不会有数据显示。如果不知道

RS-LiDAR-16的 MSOP端口和 DIFOP端口，可以连接设备到电脑后，使用Wireshark软件抓

包查看 LiDAR数据包的 Dst Port。

点击 Tools > Data Port，输入修改后的 RS-LiDAR-16 MSOP Port 和 DIFOP Port，然后点

击 Set Data Port。
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图 C-17 设置端口号

C.9 在线固件升级

需要首先保证 RS-LiDAR-16设备已经正常连接，并可以正常显示点云和获取 C.8中工厂

固件信息。

点击 Tools > Online Update，如图 C-18所示显示，可以选择主板固件更新和底板固件。

图 C-18 在线升级

例如，点击 Bottom Board Update后在弹出的窗口中选择升级所需的.rpd固件文件，然

后点击打开，开始底板固件的在线升级。升级过程会持续一段时间，升级完成后会显示

“Online Update Successful”

注：Config Updata选项不可用。
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图 C-19 选择升级固件

图 C-20 更新成功

C.10 故障诊断

需要首先保证 RS-LiDAR-16设备已经正常连接，并可以正常显示点云和获取 C.8中工厂

固件信息。

点击 Tools > Fault Diagnosis，弹出故障诊断窗口。点击 Start 按钮可以开始对

RS-LiDAR-16的实时状态监控，包含有电流、电压、温度、数据误码率等信息监控。
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图 C-21 故障诊断
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附录 D RS-LiDAR-16ROS Package

本附录将说明如何使用 Ubuntu+ROS来获取和可视化 RS-LiDAR-16的数据。

D.1 安装软件

1. 下载并安装 Ubunutu 16.04操作系统。

2. 根据链接（http://wiki.ros.org/kinetic/Installation）安装并测试 ROS kinetic基本功能。

3. 下载并安装 libpcap-dev.

D.2 编译 RS-LiDAR-16 ROS Package

1. 创建 ros工作目录：

cd ~

mkdir -p catkin_ws/src

2. 拷贝对应您购买的 RS-LiDAR-16对应的 ros_rslidar驱动到 ROS工作目录~/catkin_ws/src

下面。最新版本的 ros_rslidar驱动可以从 https://github.com/RoboSense-LiDAR/ros_rslidar

下载。

3. 在终端中运行如下命令进行编译：

cd ~/catkin_ws

catkin_make

4. 放入 U盘中对应雷达的参数文件：

雷达参数文件在随雷达出货的 U盘中，需要将 U盘中的 configuration_data文件夹内容

拷贝到 launch文件中指定的文件夹下即可，此路径可自定义，例如：

rslidar_pointcloud/data/rs_lidar_16。

注：如若配件中无 U盘或者 U盘中无 configuration_data文件夹则不需要放置，使用默认即可。

D.3 配置电脑 IP

默认 RS-LiDAR-16固件情况下，配置电脑系统的静态 IP地址为“192.168.1.102”，子网

掩码为“255.255.255.0”，网关不需要配置。

配置完成后，可以通过 ifconfig命令查看静态 IP是否生效。
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D.4 实时显示

1. 将 RS-LiDAR-16连接网线到电脑，并且上电，运行，等待电脑识别到 LiDAR设备。

2. 使用 ros_rslidar 包里面提供的 launch 文件运行来启动实时显示数据的节点程序，该

launch文件位于 rslidar_pointcloud/launch。打开一个终端运行：

cd ~/catkin_ws

source devel/setup.bash

roslaunch rslidar_pointcloud rs_lidar_16.launch

3. 在另外一个终端中运行：

rviz

然后设置Fixed Frame为 rslidar，添加PointCloud2类型的消息并设置 topic为 rslidar_points。

图 D-1 rviz显示 RS-LiDAR-16点云数据

D.5 查看离线数据

可以利用 ros_rslidar来将保存的离线 pcap文件解析成点云数据进行显示。

1. 修改 rs_lidar_16.launch文件为如下（主要修改标记为红色的那一行）：

<launch>

<arg name="model" default="RS16" />

<arg name="device_ip" default="192.168.1.200" />

<arg name="msop_port" default="6699" />

<arg name="difop_port" default="7788" />
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<arg name="lidar_param_path" default="$(find rslidar_pointcloud)/data/rs_lidar_16/"/>

<node name="rslidar_node" pkg="rslidar_driver" type="rslidar_node" output="screen" >

<param name="model" value="$(arg model)"/>

<param name="device_ip" value="$(arg device_ip)" />

<param name="msop_port" value="$(arg msop_port)" />

<param name="difop_port" value="$(arg difop_port)"/>

<param name="pcap" value="指向.pcap 的绝对路径"/>

</node>

<node name="cloud_node" pkg="rslidar_pointcloud" type="cloud_node" output="screen" >

<param name="model" value="$(arg model)"/>

<param name="curves_path" value="$(arg lidar_param_path)/curves.csv" />

<param name="angle_path" value="$(arg lidar_param_path)/angle.csv" />

<param name="channel_path" value="$(arg lidar_param_path)/ChannelNum.csv" />

</node>

<node name="rviz" pkg="rviz" type="rviz" args="-d $(find rslidar_pointcloud)/rviz_cfg/rslidar.rviz" />

</launch>

2. 打开终端，运行节点程序：

cd ~/catkin_ws

source devel/setup.bash

roslaunch rslidar_pointcloud rs_lidar_16.launch

3. 通查看实时数据第 3步一样。
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附录 E 结构图纸
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附录 F 机械安装建议

如下图所示，用于固定激光雷达的安装底座建议尽可能的平整，不要出现凹凸不平的

现象。

安装底座上的定位柱应严格遵循激光雷达底部定位柱的深度，定位柱的高度不能高于

4mm。安装底座的材质建议使用铝合金材质，有助于激光雷达的散热。

激光雷达安装的时候，如果激光雷达上下面都有接触式的安装面，请确保安装面之间

的间距大于激光雷达的高度，避免挤压激光雷达。

激光雷达固定安装的时候，倾斜角度不建议超过 90度，倾斜角度过大会对激光雷达的

寿命造成影响。

激光雷达安装走线的时候，不要将雷达上面的线拉的太紧绷，需要保持线缆具有一定

的松弛。

雷达安装示意图
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附录 G 查找MSOP和 DIFOP类型的包对应的端口

根据第 5 章描述 RS-LiDAR-16 会输出 MSOP 和 DIFOP 两种类型的包，可以使用

wireshark工具过滤包内容来区分MSOP和DIFOP包的输出端口，从而在RSView中进行Data

Port设置的时候使用。

连上设备到电脑，并且给设备供电，启动 wireshark，选择正确的网口，开始抓包过程。

在应用显示过滤器中输入 data.data[0:1]==55表达式可以过滤出其中的 MSOP包，在 Info栏

中可以获取雷达数据中 MSOP端口号，如图 G-1所示；同理输入 data.data[0:1]==a5表达式

则可以得到雷达数据中 DIFOP端口号，如图 G-2所示。

图 G-1 wireshark过滤 MSOP端口号方法

图 G-2 wireshark过滤 DIFOP端口号方法
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附录 H 传感器清洁

为了能够准确地感知周围环境，RS-LiDAR需要保持洁净，特别是环形的防护罩。

H.1 注意事项

请在清理 RS-LiDAR前仔细并完整的阅读本附录 H的内容，否则不当的操作可能会损

坏设备。

雷达在环境比较恶劣的情况下使用，需要及时清理表面的脏污保持雷达清洁，否则会

影响雷达的正常使用。

H.2 需要的材料

1. 洁净的纤维布

2. 装有中性的温洗皂液的喷雾

3. 装有洁净的水的喷雾

4. 异丙醇溶剂

5. 干净的手套

H.3 清洁方法

如果雷达的表面只是粘附了一些灰尘/粉尘，可直接用洁净的纤维布粘少量的异丙醇溶

液，然后轻轻地对雷达表面拭擦清洁，再用一块干燥洁净的纤维布将其擦干。

如果雷达表面沾上了泥浆等块状异物，首先应使用洁净水喷洒在雷达脏污部位表面让

泥浆等异物脱离（注意：不能直接用纤维布将泥浆擦掉，这样做可能会划伤表面特别是防护

罩表面）。其次用温的肥皂水喷洒在脏污部位，因肥皂水的润滑作用可加速异物的脱离。再

次用纤维布轻轻试擦雷达表面，但注意不要擦伤表面。最后用洁净的水清洗雷达表面肥皂的

残留（如果表面仍有残留，可用异丙醇溶液对其再次清洁），同时用一块干燥的微纤微布擦

干。
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